
Laser Cutting and Engraving 
True to its name, a laser cutter is a machine which uses a high powered laser to burn into and 
sometimes through materials. The machine used in the Library is an Epilog Mini 12”x18” laser 
engraver. People refer to these machines as either “laser cutters” or “laser engravers”, but they can 
do both! We will refer to these two modes as engrave and cut 

Engrave - engraves photographs, shapes, and text into the 
top layer of a material 
Speed and power settings determine the depth and color of the 
engraving. Some materials darken when engraved (sometimes 
dramatically) and some do not. Image resolution also affects color 
and depth- an image engraved at 600 DPI has twice as many dots as 
one engraved at 300, and will look sharper, build up more heat and 
remove more material. 

Cut - cuts a thin line all the way through a material 
Generally, our laser can cut materials up to ¼” thick. Speed and power 
settings determine the depth of the cut, while frequency affects how 
much heat builds up on the material. Low frequency is desirable for 
materials like wood and paper that can char, while high is best for 
materials like acrylic where melting creates a clean edge. 

Combined Mode 
In combined mode the laser will engrave first and cut second. 

Here are some examples of 
things you can make → 

They can be 2D or 3D, soft 
or hard, organic or 
synthetic, and even flat or 
round! 
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Laser Cutter: Dangers and Mishaps 
The Laser Cutter is quite safe and you are almost totally free to experiment without risk. This 
page lists the exceptions to that. Aside from these items, the worst thing that can happen is 
losing a bit of time or material. Plus, they’re all pretty obvious once you know them � 

1. The laser can start fires � 

○ The laser cutter must always be monitored while in use. Pause before leaving the room. 

○ Small fires (a few birthday candle sized) are OKAY 

■ If you’re worried, just pause the print and blow them out 

○ Big fires (spreading) are BAD 

■ Stop the machine 

■ There is a tech-safe fire extinguisher beside the whiteboard, or 

■ Notify staff, and exit the building 

2. Appropriate materials and power settings must be used 

○ Failing to do so can create ☠ poisonous gasses ☠, � fire �, or damage the laser 

○ A table of materials can be found on Page 24. Material settings can be found on Page 27. 

3. The laser creates fumes 

○ The secondary exhaust fan must always be used for cutting 

○ Doors must be closed 

○ Windows must be closed, especially if there are strong winds 

4. The laser is bright 
○ Looking at it is fine, but be mindful of how long you stare (not all day every day) 

5. The laser is hot 
○ Be careful when removing materials such as glass or metal immediately after they’ve 

been engraved 

6. Don’t reach in while things are moving 

○ Fingers can get pinched, the machine can get hurt too. Pause the job first! 

7. Engraved glass creates glass powder 
○ Clean glass projects before touching the engraved area 
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1. Project Considerations 

For the most part, you can create whatever your imagination is inspired by, but there are a few 
limitations and considerations which are great to start with: 

● It always takes longer than you’d expect 
○ Give your time estimates ample tolerance (1.5x) 

● Reservations take priority 
○ While it is totally okay to drop in during Library Hours, you’ll still have to put in a 

reservation 
○ You can reserve time at https://estesvalleylibrary.org/makerspace/ 

● There is a maximum size for materials 
○ 12” x 18” for flat materials and ¼” maximum thickness 
○ The size of a wine bottle for rotary printing 
○ If you’re project is too big, ask staff for ways to make it work 

● Low contrast printing is hard 
○ Projects are best if they are black and white, with no grays or gradients 
○ Getting projects with more colors than these two requires Advanced strategies that 

can be found in the “Advanced Laser Software Strategies” Binder 
● The Laser needs to heat up 

○ If you start a project from a cold laser, the first few seconds of the engraving will be 
blank. Testing on cardboard is recommended. 

○ It takes about 5 seconds of cutting or 45 of engraving to heat the laser 
○ Once heated, it should stay so for a few hours 

● The printing program “Adobe Illustrator” requires specific file types 
○ The types are typically .svg or .ai 
○ All standard image types can be imported (.png, .jpg, .bmp, etc) 
○ For other file types, you may encounter issues with the scaling and size on import 

● Know your materials 
○ Bad materials can create ☠ poisonous gasses ☠, or damage the laser 
○ Review the table of materials which can be found on Page 24 
○ If you’re unsure, ask staff 

● Have enough material 
○ Bring more than you think you need 
○ There are often scrap materials in cabinet 10 

● Test on real material if you can 
○ Testing on cardboard is great, but many things change when using the real material 
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2. Basic Adobe Illustrator Laser Project 

2a. The Goal (Raster vs Vector) 
The overall goal of using Adobe Illustrator is to make a project containing 
layers for etching and layers for cutting. 

In order to create these layers, we use two different types of computer 
imagery called raster and vector. A raster image is just a basic picture: it is 
like handing someone a photograph. But a vector image is different. It is 
like teaching someone how to draw a 5-point star. Once they know the set 
of instructions on how to do it, they can draw one in any size and any color with any tool. This is 
the value that vectors have over rasters. As the saying goes: “Teach a person to fish…” 

We can also use these vector layers to tell the laser what lines to cut. There is more information 
about cutting in the Stroke Width section on Page 10 

2b. Starting a New Project 
1. Open Adobe Illustrator by finding and double-clicking its icon on the desktop → 
2. In Adobe Illustrator, use the Create New button or go to File > New 
3. There are options on the right to make your artboard the same size as your material piece. 

This will help you place your designs exactly where you want them to appear on the material. 
○ You can also resize your artboard later (details in Section 2f) 

4. In the bottom right hand corner, click Create 
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2c. Basic Computer Commands (Copy, Paste, Undo) 
There is a set of standardized computer commands that are used by almost all programs and are 
essential to know about. These commands relate to three concepts: 

● Selection is whatever text or images you’re currently highlighting. 
● The clipboard is a temporary storage space for moving things from one place to another. 

Imagine a box on your desk that can only contain a single thing at a time. 
● Edit history is a list of actions you’ve taken within a program. They allow you to go back in 

time. 

In order to interact with the clipboard and edit history, there are various commands which can be 
found under the Edit menu located in the topbar menu at the top of your program. Alternatively, 
these commands can often (but not always) be found by right clicking things you want to copy or 
places you want to paste. If one way doesn’t work, try the other. The commands are: 

● Copy - Takes a highlighted or selected item and puts it on your clipboard. Anything already 
there will be replaced. 

● Paste - Duplicates whatever is on your clipboard. This can be done as many times as you 
like. 

● Undo - Goes back in edit history one action at a time. If you make a mistake, do not fret! 
Undo is here to help! 

● Cut - Similar to Copy but it removes the selection from where it is when moving it to your 
clipboard 
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2d. The Workspace (Artboard) 
Imagine a desk with a sheet of paper that you’re pasting various cut-outs and clippings on in order 
to create a collage. 

In this metaphor, your desk would be the Workspace, your sheet of paper would be the Artboard 
and the cut-outs and clippings would be Objects which each exist on different Layers. 

Unlike regular paper, the size of the Artboard can be changed to match your material size. To do 
this use the Selection Tool to click anywhere in the empty gray Workspace area (thus selecting it), 
then going to the Properties Pane and clicking Edit Artboards. 
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2e. Window Panes (Properties, Layers, Align) 
The Window Panes are small, special purpose boxes usually found on the right side of the 
program. You can add or remove these panes by opening the Window menu in the topbar. To get 
the standard set used for laser cutting, go to Window > Workspace > Reset Laser Workspace. This 
will open the following panes on the right hand side: 

● Properties Pane - shows details about whatever is currently selected 
● Layers Pane - shows which layer (background, foreground, etc.) is currently selected. 

(Advanced) Also allows you to move layers in front of each other, select them, delete them, 
duplicate, hide, etc. 

● Align Pane - (advanced) helps center items within the artboard or relative to each other 
● Image Trace Pane - (advanced) is used to stencil images in ways that make them look better 

when printed. Instructions can be found in the “Advanced Laser Software Strategies” 
Binder. 

8 



2f. Basic Tools (Move, Shapes, Rotate, Text, etc) 
Tools are the ways in which you interact with the program. Depending on which tool you have 
selected, clicking will do different things, much like having a tool in your hand. The toolbar is found 
on the left side. 

● Selection Tool - This is the most important tool. This is how you select objects, move 
objects, and resize objects. If this tool is not selected, clicking will do surprising things. 

○ You can also nudge selected objects by using the arrow keys. This is useful for 
getting pixel perfect results. 

○ Whenever an object is selected, its details will be displayed in the Properties Pane. 
○ Try to make a habit of always defaulting back to this tool. 

● Text Tool - Used to create or to edit highlighted text’s font and size with the Properties Pane. 
● Shape Tool - Used to create squares, ellipses, lines, or other simple shapes. 

○ Right click the tools icon to view shapes other than rectangles. 
● Rotation Tool - Used to rotate an object 
● Pen & Curvature Tools and Direct Selection Tool- (Advanced) Used to draw custom shapes 

or select individual points of an object. 

No matter what tool is selected, you can zoom in and out by rotating the scroll wheel on the mouse 
or move your view around by clicking the scroll wheel in and then dragging. 

Remember: Undo is your friend! 
If anything strange ever happens, you can just undo it 
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2g. Cutting Stroke Width 
Vector shapes can draw any size stroke width you want, from super fine to extra thick. If you want 
these lines to cut rather than engrave, there is a certain lower limit which tells the laser cutter to 
switch from engraving to cutting. That limit is .08 pt / .001 in. Any stroke thinner than this will be 
interpreted as cutting instructions, anything bigger will be engraved. You must also set a color. 
Typically, people use colors like black or red. You may also want to set fill to none. 

2h. Print Settings 
Printing requires a bit of setup to make sure your piece has the right orientation, size, position, as 
well as cutting and etching powers. 

Print Menu 

● Go to File > Print to open the Print Menu 

● Make sure Auto-Rotate (1) is disabled by 
unchecking the box 

● Make sure Placement (2) has the top left 
box selected 

● Go to Setup (3) 
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Printer Setup Menu 

● Make sure Epilog Engraver X64 Ethernet 
is selected 

● Click Preferences 

Epilog Engraver Properties 

This panel is where you manage how the Laser Cutter will engrave and cut. 

Easy Way - If you want to do things the easy 
way, you can click the Advanced Tab at the 
top to display a list of material presets. 
Select one and hit Load. 

Advanced Way - For special materials or 
fine-tuning, you can specify every aspect of 
how your print will run in the General Tab. 
This settings pane refers to engraving as 
“raster” and cutting as “vector”, though 
vectors will be engraved if they don’t have a 
super thin line. Specifications for known 
materials and their settings can be found in 
“Table II: Material Settings” on Page 27. The 
settings available are: 
● Resolution (Raster) - defines how closely 

packed the burn dots will be 
● Job Type - you can choose to engrave 

(Raster), cut (Vector), or both (Combined) 
● Piece Size - any size bigger than your print 

and smaller than the printer bed will do 
here 

● Speed (Raster and Vector) - defines how 
quickly the laser head will move, and how 
long the print will take 

● Power (Raster and Vector) - defines how hot the laser will burn 
● Freq (Vector) - number of zaps per inch. Similar to resolution, but for vectors. 
● Image Dithering (Raster) - changes the style of shading 
● Options 
○ Auto Focus - when enabled, the Laser Cutter will find its ideal focal length automatically. For 

some (Advanced) projects that aren’t flat enough, focus must be done manually. Details can 
be found in the “Manual Focus” section on Page 17 

○ Center Engraving - when enabled, prints will center on the home position. Details can be 
found in the “Centering a Print at Arbitrary Locations” section on Page 17 

For any nitty gritty details, the manufacturers manual is in the binder next to the Laser Cutter 
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Once you have input your settings… 

1. Make sure the laser is on 
2. Keep clicking the Okay and Print buttons until the instructions are sent to the Laser 

Cutter 
3. Follow the instructions in “Section 3: Running the Machine” 

3. Running the Machine 

3a. Power On 

Turn on the Laser/Exhaust If the laser doesn’t come on, The laser will boot up and you 
switch under the counter. You check that the large switch will hear the X and Y axis 
can also turn Air Assist on near the plug on the lower rear motors checking their home 
now if you like. part of the left side is flipped position 

to | (on) 

3b. Choose Your Print 
Creating your art is likely the hardest and most time consuming part of using the laser. It is a skill 
unto itself. There are details on how to setup a simple artwork on Page 5, as well as separate 
Advanced tutorials available in the “Advanced Laser Software Strategies” Binder 

3c. Choose Your Material 
Which material you choose can depend heavily on the type of project you’re trying to make. There 
are many different material types, and thicknesses of each. Examples include things like wood, 
cloth, paper, acrylic, leather, metal, glass, cork, or stone. You can find more information in Table I -
Printing Materials on Page 24 
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3d. Choose Your Printing Insert 
For the vast majority of purposes – especially introductory ones – the honeycomb grid will work 
perfectly. But there are some projects that require a different printing insert. Details on how to 
change setups can be found in the Advanced Section on Page 16. The three insert types can all 
be found in Cabinet 10, and they include: 

Honeycomb Grid - (default) used for the vast 
majority of materials which are heavy enough that 
they won’t blow around, but light enough they won’t 
bend the insert. 

The open grid minimizes scorch marks on the back 
of your material caused by the laser beam bouncing 
off the metal. 

Vacuum Table - (solid with small holes) used for 
engraving/cutting on light materials/objects that 
need suction, magnets, and/or tape to stay in place. 
Also used for very heavy materials that might bend 
the honeycomb grid. 

The more holes in the table that are covered, the 
more light materials will be held in place. You can 
cover any exposed holes with scrap material or use 
the magnets on the whiteboard and/or painters tape 
to hold your light materials in place if needed 

Rotary Attachment - used for round objects, typically 
glass or metal bottles. 

Can also handle tapered (cone like) objects; see the 
full Advanced Section tutorial on Page 18 

3e. Placing Your Material 
The top-left corner is where material will be placed for the vast majority of projects. The 
exceptions to this will be when printing from arbitrary locations, or using the rotary attachment. 
Details of these cases can be found in the Advanced Section on Page 18 
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3f. Control Panel 
The top row of the Control Panel on the laser contains 3 basic buttons, and 3 intermediate buttons 
to know about. Usage for the rest of the buttons can be found in various Advanced Tutorials on 
Page 16. The top-row basic and intermediate buttons include (in order): 

● Basic (need to know): 
○ Go - Starts a selected print 
○ Pause - Pauses a running print 
○ Reset - Ends a print entirely, and returns laser to home position. It is also used in 

navigating Advanced menus 
● Intermediate (for non top-left aligned projects): 

○ Set Home - Chooses a new home position 
○ X/Y Off - Unlocks the laser head so it can manually be moved in order to set a new 

home position 
○ Laser Pointer - Shines a laser pointer; helpful for seeing where the new home location 

will be 
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3g. Uploading and Running the Job 
Jobs are uploaded through the Adobe Illustrator program. You can find more information in “3h. 
Print Settings” on Page 11. 

Running the Job Checklist 
Exhaust fan is on 

Laser is warmed up. Use cardboard to test it. 
The LCD screen shows your project name. It will be “Untitled” if no name has been given. 
(Bonus) Cardboard test was successful 

To run, hit the Go button 

3h. While the Job Runs 
● Stay within arms reach of the laser during engraving, and watch the job during cutting. 
● Follow the instructions on Page 1 if you see flames. 
● To pause the job, use the red Pause Button. Resume with the green Go Button. 
● To end the job, use the red Pause Button and then the black arrow Reset Button. 

3i. When Done (Cleanup) 
Remove any debris from the laser bed 

Turn off the laser, the Laser/Exhaust switch and the Air Assist pump switch. 
Shut down Adobe Illustrator. If you want to save your work, use a thumb drive or email 
yourself the file. 
(Bonus) Pull very hard on one front access door handle to open it, then flip out the two 
latches on the crumb tray, slide it out, dump it in the trash, and put it back. 

3j. Finishing Artistic Touches 
● For any cuts that did not go all the way through, use a box-cutter or exacto knife to finish the 

cuts from the back 
● For burn smudges and stains on wood, you can clean the surface with isopropyl-alcohol or 

sand paper 
● Coating with stains and paints can really bring some pieces to life 
● For prints that need assembly, super glue and hot-glue are available in Cabinet 9. The latter 

is easier to use but harder to hide. 
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4. Advanced Machine Techniques 

4a. Changing the Insert 
● Press the Focus button and use the up/down buttons to lower the table several inches. 
● Flip up the spring-loaded rulers on the left, top, and right sides of the enclosure 
● Load the insert (honeycomb grid with its metal rim down, vacuum table shiny side up), and 

flip the rulers down 

4b. Printing at Arbitrary Locations 
To change the Home Position from which the prints will start: 

4c. Resetting to Top Left Corner 
To undo a previously set Home Position, use the Maintenance button as shown in the previous 
image. 
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4d. Centering a Print at Arbitrary Locations 
Centering a print can be very useful for items like coasters or book covers. It allows one to point 
the laser at the center of their material, and the laser does the rest from there. 

First follow the instruction in “Printing at Arbitrary Locations” to move your Home Position to the 
center of where you want to print. Then, in the Epilog Engraver Properties panel (shown in section 
“2d. Print Settings” on Page 11), enable the Center-Engraving option. 

It is highly recommended that you do a test print by drawing a small dot on some cardboard and 
then targeting the dot. This will make it obvious if you need to offset your print. 

4e. Manual focus 
Good for small or unusually shaped items or soft surfaces, situations where you want a little extra 
certainty, or would prefer the autofocus plunger not touch your material (which could move it) 

1. Grab the focus gauge from the top left side of the laser printer and place it onto the laser 
carriage. A magnet will hold it in place. 

2. Press Focus on the control panel, then use the control panel’s up/down arrows to 
raise/lower the table until the material surface just barely touches the tip of the focus 
gauge. It doesn’t have to be perfect. If you lower the focus gauge into the material, it will 
move up without hurting anything and eventually pop off the magnet. 

○ If your material is uneven, select a medium distance between the high and low points. 
○ If there is more than 3mm of variation in your surface, parts of your engraving may 

look fuzzy and the beam might not cut all the way through during vector cutting (the 
more out of focus the beam is, the weaker it is) 

3. You will uncheck Auto Focus in the Laser Dashboard during the printing step (see Page 11). 
4. Press the reset button (back arrow) on the laser panel to exit focus mode. 
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4f. Using the Rotary Attachment 
This section requires knowledge of how to switch the plate, use manual focus, center-engrave, 
and print from arbitrary locations. The Rotary Attachment can be found in Cabinet 10. 

The value of the rotary attachment is that it can be used to print on cylindrical objects such as 
bottles, dowels, or jars. It is generally only used for engraving, typically on glass or paint covered 
metal. 

Parts of the rotary 

● The drive wheels on the right side are motorized and spin your object 
● The support wheels on the left side roll 

with the object and can be raised up 
and down to make the surface of your 
object level. If your object has a narrow 
side, place it on these wheels. 

● Push the left side of your object 
against the bumper. 
The bumper is the start point of the 
engraving. 

● Flip the release lever toward the front 
of the laser to slide the support wheels 
right. Flip it back to lock. 

● Use this knob to raise and lower the 
support wheels to level your object. Consider using one of the small levels found on the 
peg board. 

Step 1: Remove the vector grid and crumb tray and install the rotary 

1. Lower the table slightly. Power the laser on. Using focus mode, lower the table a few 
inches so you have room to flip the rulers up. 

2. Remove the vector grid. Flip up the spring-loaded left, top, and right rulers and remove any 
insert. See “5a. Changing the Insert” on Page 16 for details. 

3. Remove the crumb tray. Open the front door (pull very, very hard on just one of the 
handles). Flip the crumb tray latches outward and slide the crumb tray out. Set aside. 

4. Lower the table completely. Using focus mode, lower the table all the way down. 
5. POWER OFF. Never plug in the rotary when the power is on. 
6. Position the rotary. With the wheels on the left side, align the 3 pins of the rotary with the 

3 holes on the bottom of the laser (the right hand pin is out of sight under a little cutout on 
the frame) 

○ When handling the rotary, try not to touch the rubber tires 
7. Plug the rotary in. Leave the power off for now. 
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Step 2: Place your object on the wheels and level it 

1. Examine your object and decide how to place it on the wheels. 
○ The rotary attachment has a scissor jack that can lift the right side of your object, 

so you’ll want to place the side that needs lifting, usually the smaller side, to the 
right. 

○ You can also place both sets of wheels under a straight/flat section of your object 
rather than under the far end. 

2. Adjust the spacing between the tires. 
○ Flip the silver release lever toward the front of the laser and slide the support 

wheels to the right until the space between the wheels is the right width for your 
object. Flip it back to lock. 

3. Place the object on the tires. 
○ Push the object against the black tab/bumper on the left side of the rotary. This 

bumper is the start point for the engraving. 
4. Level the object. 

○ Use a level from the pegboard on the top edge of your object, then rotate the 
scissor jack knob to raise/lower the right side if needed. 

5. Turn the laser on. 
○ With the rotary plugged in, the laser will automatically set the home position to the 

black bumper (X 0, Y at the centerline of the rotary) 

Step 3: Focus and Position Laser 
Read the sections “Printing at Arbitrary Locations” and “Manual Focus” 
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Step 4: Create a document and position your design 

1. In Adobe Illustrator, use Create New to make a document the same size as your object. 
○ Document width: length (right to left) of the object when it’s horizontal, starting 

from the left side 
○ Document height: Distance from your starting point to the end of your design 

2. Refer to the examples on the next page for tips on how to position your design on the 
document. 
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Step 5: Print 
● Refer to the Laser Cutter training for full printing instructions, with these special 

considerations: 
○ Resolution: Use 300 DPI for glass- higher DPI settings get flaky/melty 
○ Job Type: Will be Raster in most cases 
○ Raster Setting: 

■ Image Dithering: Jarvis is recommended for glass 
○ Options: 

■ Auto focus should be unchecked 
■ Center-Engraving should be unchecked 

○ Page Size: Same as your document- width is the object length, height is the object 
circumference 

● The laser automatically detects the rotary and knows to spin the object rather than 
moving the Y axis. 

● Remember to warm up the laser tube on scrap material (use your own test object). You 
don’t need to re-level or change focus, just look for a visible beam. 

● Use the material settings from the “Table II: Material Settings” on Page 27. 
● Especially when using the rotary, run the job with the lid up (disabling the laser) and the 

red dot pointer on to confirm that the object is stable on the wheels and that the laser is 
traveling to the area you want to engrave. Then run again with the lid down. 

Glass Tips 

● When removing glass, do not touch the engraved area when removing the item. Rinse the 
engraving under water and use a scrub pad to remove the glass powder. 

● Try changing the fill color of your design to 80% gray (that’s the third gray from the left in 
the Illustrator Swatches panel. Hover over the swatches to see the K percentage) rather 
than using pure black. 

● Use the Jarvis rather than the Standard dither for a frosty appearance. 
● Avoid engraving over already engraved areas as it may crack the glass. 

Warning! Glass powder irritates eyes and skin 
Make sure to wash off your piece before handling it too much 
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5. Common Tech Issues 

5a. Print Beeps Complete Having Done Nothing 
● Check that your job type is right for your job (vector for cutting, raster for engraving, 

combined for both) 
○ If your job is Combined, try running it first as vector only and then as engraving only 

to help diagnose the problem 
● Check that you are using a printable layer 

○ Open the Layers window, click on the 3 lines in the upper right corner of this 
window, and choose “Options for Layer” 

○ Make sure the “Print” box is checked (this is mostly a problem with designs that 
have been downloaded) 

● For vector cutting jobs, check that your line: 
○ is a vector line (click with the white Direct Select 

tool and make sure you can you can see a path, 
points, and handles) 

○ Is the right width (0.08 pt/0.001 in) 
○ Is a color (red or black are common choices) 
○ Is aligned to the center of the path. In the 

Properties pane, click the word Stroke and check 
that Align to Center is selected rather than Inside 
or Outside, and that Dashed Line is unchecked 

5b. Vectors Are Being Etched Instead of Cut 
● Check your stroke width 
● Try bringing your cutting layers to the top 
● Check your layers to make sure that cutting and engraving layers are not being combined 

into the same sub-layer 
● Try making all engraving layers invisible (click the eye in the Layer Pane), then print again 

5c. Laser Not Cutting All the Way Through 
● Check focus 
● Check line width and color 
● Let makerspace@estesvalleylibrary.org know that the 

laser optics may need to be inspected and cleaned 

5d. Plunger Folded, Machine Jammed 
First, don’t panic, the autofocus plunger is spring loaded and it can fold over without damage. 
You will need to manually lower the table so the laser can check its x and y axis during startup 
without getting caught: 

1. Turn off the laser 
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2. Pull hard on the handles on the front door of the laser 
3. Grab the first belt you see running along the bottom of the laser’s case and pull it to the 

right to slowly lower the table. You’ll probably have to pull on the belt a few times to get 
the bed low enough that the autofocus plunger is no longer folded over. 

4. Close the front door and turn the laser on. It should be able to run through its normal 
setup process. 

In the future, avoid using Auto Focus with bumpy, uneven, or oddly sized materials, or material 
sheets with holes in them. If the autofocus plunger touches down at an angle, it can fold over. 

5e. Laser Starting in Wrong Position 
Check that someone didn’t accidentally set a new home location. To reset, see section “4a. 
Resetting to Top Left Corner” on Page 17 

5f. Print Showing Up in Wrong Location 
This is likely an issue with your Print Settings. Follow the steps in “3d. Print Settings” on Page 11 

5g. Position Error 
This means the printer is trying to move out of bounds. Check that your bounds are correct in 
the Epilog Settings, and that center-engraving is not accidentally checked. 

5h. If All Else Fails… Ask For Help 
Most days, there is a staff member or makerspace guide who can help. Alternatively, you can 
reach out to us at makerspace@estesvalleylibrary.org and we’ll get back to you as soon as 
possible. 

You can also try checking online (youtube, stack exchange, quora, etc), or in the machine’s 
manuals (found in the binder). 
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6. Table I: Printing Materials 

Bad Laser Materials 
Adapted from ATXhs.org | Always positively identify your materials before cutting 

PVC (polyvinyl 
chloride), including 

vinyl and 
pleather/artificial 

leather 

Emits noxious chlorine 
gas when cut! 

Don't ever cut materials containing chloride as they 
release chlorine gas that will corrode the inside of the 

laser, damaging the optics and motion control 
system. It’s bad for people too! If you aren’t sure your 

material doesn’t contain chlorides, don’t cut it! 

Polycarbonate/Lexan 
Cuts poorly, discolors, 
damages laser optics 

Although it might look just like acrylic, polycarbonate 
absorbs the laser’s light frequency, causing 

discoloration and poor cutting performance. The 
inefficient cutting process creates stringy soot that 

can coat and damage the laser optics. 

ABS 
Cuts poorly, melts, 

catches fire, emits fumes 

ABS cuts and engraves poorly on a CO2 laser. It tends 
to melt rather than vaporizing, creating ugly cut edges 

and risking fire. It also emits noxious fumes. 

Polystyrene Foam Catches fire 
Catches fire quickly and burns rapidly. Polystyrene 

foam is the #1 cause of laser fires! 

Polypropylene Foam Catches fire 
Like polystyrene, it melts, catches fire, 

and the melted drops continue to burn and turn into 
rock-hard drips and pebbles. 

Epoxy Emits noxious fumes 
CO2 lasers can't cut through it, and attempting to cut 
it releases toxic fumes. Items coated in epoxy or cast 
epoxy resins should not be used in the laser cutter. 

Fiberglass 
Can’t be cut, emits 
noxious fumes 

It's a mix of two materials that can’t be cut. The laser 
can’t cut the glass fibers, and the epoxy resin can’t be 

cut AND releases fumes 

Coated Carbon Fiber Emits noxious fumes 
Thin carbon fiber mat can be cut, 
but not when coated with epoxy 

Material with “PSA” 
glue backing 

Damages laser optics 

Otherwise suitable materials like wood veneer 
create sticky soot that can damage the laser optics 
if they have a “PSA” glue backing. Please do not cut 

sheets of material that have a PSA backing. 

Polyethylene 
(HDPE & LDPE) 

Cuts poorly, melts 
Plastics commonly found in packaging materials 

(milk bottles, butter tubs, etc). It melts and 
becomes gooey and waxy, with messy edges 
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Good & OK Laser Materials 
● Always positively identify your materials before cutting 
● Bring extra materials and plan to test your settings before working on your project 
● Check the laser binder for recommended settings 
● Our laser cannot cut metal, no matter how thin! See the next page for ways to engrave 

on metal 

Cut & Engrave 

Acrylic/Plexiglass 

Cuts beautifully! One of the best materials for laser cutting. 
We buy our acrylic from estreetplastics.com. Cast acrylic engraves better than 
extruded acrylic, so look for “cast” in the product description if you’re buying for 
an engraving project. 

Specialty laser 
plastics & sheet 

materials 

Check the “Laser” section of online engraving suppliers like jpplus.com for 
plastics and other sheet materials specially selected for laser use, including 
two-layer plastics for high-contrast engraving 

Wood 

Baltic birch plywood, alder, and cherry give especially nice results and white 
pine, oak, and balsa are also recommended. Woods with a tighter grain make 
for clearer engravings, but wood with a bold grain can give an interesting 
artistic result. Plywood is more difficult to cut than solid wood and our 
low-power tube will struggle with plywood sheets thicker than about ⅝”. Test 
on different woods before pursuing a large project to make sure you like the 
results. Wood specially selected for laser cutting can be purchased from 
engraving suppliers like jpplus.com. 

Eucaboard brand 
hardboard 

Eucaboard by Eucatex is a common brand of high-density fiberboard that cuts 
and engraves beautifully in the laser and contains no glues. It’s made entirely 
of eucalyptus fiber, so no worries about releasing fumes. Check the back of 
HDF sheets at Home Depot, Lowes, etc, for this brand to guarantee an excellent 
laser experience. 

Paper & Cardboard 

Cardboard is a great material for the beginner laser cutter enthusiast since it’s 
cheap or free! It cuts better than it engraves. The laser cuts even delicate paper 
beautifully at low power levels- use the solid vacuum table and magnets or tape 
to hold the paper down. 

Fabric 
The laser can cut both synthetic and natural fabrics on low power levels. 
Use the solid vacuum table with magnets or tape to hold it down. 

Taskboard 

Taskboard is a dense, solid paper product about halfway between cardstock 
and balsa wood. It engraves and cuts beautifully. Highly recommended for craft 
projects. Commonly used for architectural models. Available from 
taskboard.com 
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Leather Leather engraves and cuts nicely, but it doesn’t smell very good. 

Cork 

Cork cuts easily and is also very rewarding to engrave, creating a clear and 
crisp black mark even on low power settings. Avoid cork with a PSA (pressure 
sensitive adhesive) backing which can create sticky smoke that is hard on the 
laser optics. 

Engraving Only 

Painted & coated 
metal 

The laser cannot cut or mark metal (not even foil!), but it CAN mark or remove 
surface coatings from painted or coated metal. Painted steel water bottles and 
other drinkware give nice results, especially on the rotary, as does anodized 
aluminum. Several passes may be required to remove the coating completely-
bring a spare item to test on! Metal sheets pretreated with a “Ceramark” coating 
work great for engraving- check engraving suppliers like jpplus.com for 
Alumamark/Ceramark or “laserable metal”. 

Promotional items 

Promotional items like keychains, coasters, wallets, jewelry boxes, etc are 
sometimes engraveable. Browse an engraving supplier like jpplus.com and 
follow their recommendations for best results. Never engrave unknown 
materials, especially plastics! You must be able to positively identify the 
specific material before engraving it (for example, alder, acrylic, anodized 
aluminum, painted steel- not just “wood” or “plastic”!) 

Glass 

Glass can be engraved with good results. Colored glass tiles are a great place 
to start. Rounded objects (bottles, wine glasses, Christmas ornaments) can be 
engraved either by propping them on the flat table, or on the optional rotary 
attachment. The rotary is best for intermediate to advanced laser users who are 
ready for a challenge. 

Ceramic Tile 
Works great, especially darker tiles with a lighter center. The laser will remove 
the top layer and expose the interior ceramic color. 

Stone 
Stone can be marked with high power settings and several passes. Slate gives 
especially good results and smooth river stones can be interesting, yet 
unpredictable. 
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7. Table II: Material Settings 

These are initial power settings for common materials. Bring extra materials for testing and plan to 
adjust your settings further. 

Key: Engrave/Raster Cut/Vector 

Material Speed Power DPI Frequency 

Wood 

Engrave photos* 40 100 600 DPI 

*Note: Plan to experiment with the dither settings to get the most appealing results on your 
material 

Engrave text/clipart (high resolution) 30 100 600 DPI 

Engrave text/clipart 25 100 300 DPI 

Cut veneer 30 22 Freq. 500 

Cut ⅛” (3mm) 20 - 25 100 Freq. 500 

Cut ¼” (6mm) 7 - 8 100 Freq. 500 

Acrylic 

Engrave photos 90 60 300 DPI 

Engrave text/clipart* 90 70 300/600 DPI 

*On transparent acrylic, try engraving at 300 DPI with image dithering set to Jarvis for the most 
opaque “frosted glass” look 

Cut ⅛” (3mm) 9 100 Freq. 5000 

Cut ¼” (6mm) 5 100 Freq. 5000 

Other plastic 

Engrave general plastic 90 40 300 DPI 

Engrave two-layer plastic (high 
resolution) 

90 70 600 DPI 

Engrave two-layer plastic 90 80 300 DPI 

Cardboard 

Cut single layer 50 50 Freq. 500 

Cut double layer 30 70 Freq. 500 
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Engrave (light mark) 100 15 300 DPI 

Copy paper 

Cut 100 15 Freq. 1000 

Eucaboard brand hardboard 

Cut 12 100 Freq. 500 

Engrave 30 100 600 DPI 

JPPlus Laserable Alderwood 

Cut (⅛”) 20 - 25 100 Freq. 500 

Engrave 30 100 600 DPI 

Taskboard 

Cut (1/16”) 50 50 Freq. 500 

Engrave 100 60 300 DPI 

Glass (engrave only) 

Text/photos (Use 80% gray instead of black 20 100 300 DPI 
with Jarvis dither) 
*Glass may be hot when finished 

Slate Coasters (engrave only) 

text 90 65 600 DPI 

photo 90 55 300 DPI 

Cork coaster 

Engrave 90 50 600 DPI 

Painted Steel Water Bottle (engrave only) 

Engrave 60 50 600 DPI 
*Bottles had thin paint. Bottles with a Yeti-like 
textured coating may need more power 

Leather ⅛” 

Engrave text 70 60 600 DPI 

Cut (⅛”) 20 80 Freq. 600 
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Material Speed Power DPI Frequency 

Rowmark LaserMax 

Engrave 85 75 600 

Cut 25 100 5000 

Red Sandstone (engrave only) 

Engrave 40-60 100 600 

Velvet 

Engrave 50 50 600 

Cut 100 30 5000 
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